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Introduction

Use this document to determine what printing-system software solution best meets your needs.

● Find descriptions of printer drivers, operating systems, and system admin tools.

● Learn what software you should install, installation method, and how to install and uninstall it.

● Discover software solutions and support that are available on the CD and on the web.
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Select a solution
Refer to the table below to determine which software solution and installation method is best for your
environment.

Environment Features SW solution

Home or small office (nonmanaged
environments, no IT/System
administrator)

● Print, scan, and fax are supported
(scan and fax capability on select
models)

● Windows and Mac are supported

● Wireless Enterprise Security and
802.1x are not supported*

● Windows Server Editions are not
supported

In-box CD

Managed environment (IT/System
administrator)

● Print, scan, and fax are supported
(scan and fax capability on select
models)

● Windows and Mac, only Windows
supports command line install

● Select Windows Server Editions are
only supported by the IT
Administrator Custom Command
Line Install

Full Software Solution or Driver
with Installer from: www.hp.com/
support (documentation and support
information, including the IT
Administrators’ Install Guide, can
be found at this site)

Managed environment (IT/System
administrator)

● Only print is supported (scan and
fax are not supported even if the
printer has this capability)

● Windows and other select
operating systems

● Select Windows Server Editions are
supported

HP Universal Print Driver (UPD)
from: www.hp.com/go/upd

NOTE: If you install Windows software from the CD, use the Printer’s Embedded Web Server (for a
single printer) or HP Web Jetadmin (WJA) (for multiple printers) to setup the printer on a network using
Wireless Enterprise or 802.1x Security.

In-box CD

Use the software CD to install the HP PCL 6 driver for Windows and PS driver for Mac operating
systems. See Windows software on page 9 or Mac software and utilities on page 36 to learn
about installing the driver, the features, and uninstalling the driver.
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Supported operating systems

● Windows 8; 32-bit and 64-bit

● Windows 7; 32-bit and 64-bit

● Windows Vista; 32-bit and 64-bit

● Windows XP; 32-bit (Service Pack 3 and higher)

● Mac OS X v10.6, OS X Lion, OS X Mountain Lion

Minimum system requirements

Windows 8, 7

● 1 GHz 32-bit (x86) or 64-bit (x64) processor

● 2 GB HD

● Microsoft Internet Explorer

● CD-ROM/DVD or Internet

● USB

Windows Vista

● 800 MHz 32-bit (x86) or 64-bit (x64) processor

● 2 GB HD

● Microsoft Internet Explorer

● CD-ROM/DVD or Internet

● USB

Windows XP SP3 (32-bit only)

● Intel Pentium II, Celeron or 233 MHz compatible processor

● 750 MB HD

● Microsoft Internet Explorer 6

● CD-ROM/DVD or Internet

● USB

Mac

● Mac OS X v10.6, OS X Lion, OS X Mountain Lion

● 1GB hard drive space
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● CD-ROM/DVD-ROM drive or Internet access

● USB port

NOTE: Go to www.microsoft.com and www.apple.com for operating system compatible hardware
system requirements.

NOTE: HP does not control and is not responsible for information on links that take you outside the
Hewlett-Packard Web site.

Basic Print Scan Driver on Web / Full Feature Software on Web

Use the printer’s software download page at www.hp.com/support to install a Full Software
Solution and Driver with Installer. Both downloads contain the HP PCL 6 driver for Windows or
the PS driver for Mac that is on the software CD. See the In-box CD on page 2 for supported operating
systems and system requirements.

● Full Software Solution is the complete software solution intended for users who want more
than just basic drivers (scan is available on select models).

● Driver with Installer is a software solution intended for users who want a basic print and scan
driver (scan is available on select models).

NOTE: You can use the command line method to install the PCL6 driver for select Windows Server
Editions.

HP Universal Print Driver (HP UPD)

Use the HP UPD to install HP UPD PCL 5, PCL 6, and PS drivers. Go to www.hp.com/go/upd for
drivers and installation instructions.

Supported client operating systems

● Microsoft Windows 8; x86 and x64.

● Microsoft Windows 7 Starter, Home Premium, Professional, Enterprise, and Ultimate; x86 and
x64.

● Microsoft Windows Vista Business, Enterprise, Home Basic, Home Premium, and Ultimate; x86
and x64.

NOTE: Microsoft retired mainstream support for Windows Vista in April 2012. HP will continue
to provide the best effort to support the current UPD and tools for the discontinued Vista operating
system.

● Microsoft Windows XP (SP2 and later) Home Edition, and Professional; x86 and x64.

NOTE: Microsoft retired mainstream support for Windows XP in April 2009. HP will continue to
provide the best effort to support for the current UPD and tools for the discontinued Windows XP
operating system.
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Supported server operating systems

● Windows 2003 Server (Standard Edition, Enterprise Edition) (32bit and 64-bit)

● Windows 2003 Server R2 (Standard Edition, Enterprise Edition) (32bit and 64-bit)

● Windows Small Business Server 2003 (32bit and 64-bit)

● Windows 2008 Server (Standard Edition, Enterprise Edition) (32bit and 64-bit)

● Windows Small Business Server 2008 (64-bit)

● Windows 2008 Server R2 (Standard Edition, Enterprise Edition) (64-bit)

● Windows Small Business Server 2011

● Windows Server 2012

● Windows Cluster (Windows Server 2008 R2)

● Windows Terminal Services (Windows Server 2008 R2)

● Windows 2003 Small Business Server Terminal Services

● Windows 2003 Server Terminal Services

● Windows 2003 Server Terminal Services with Citrix Metaframe XP with Feature Release 3

● Windows Server 2003 Terminal Services with Citrix Presentation Server 4.0

● Windows Server 2003 Terminal Services with Citrix Presentation Server 4.5

● Windows Server 2008 Terminal Services

● Windows Server 2008 Terminal Services with Citrix XenApp

● Citrix (Print): Xen Server 5.6, Xen Desktop 5.5, Citirx XenApps 6.0, Citrix XenApp 6.5

● Novell Netware 6, 6.5, Open Enterprise Server 6.5 (Novell iPrint support only)

NOTE: For additional details on client and server operating systems for the HP Universal Print Driver
(UPD), go to www.hp.com/go/upd and click the Specifications tab.

NOTE: Microsoft discontinued mainstream support for Windows XP. However, HP will continue to
provide best effort support for its print drivers in Windows XP.

NOTE: For updated information, refer to the latest release notes available on the driver download
page.
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Links to software and support

Print drivers

● HP Basic Print (PCL6) and Scan Driver for Windows and Full Feature Software and
Drivers for Windows (PCL6) and Mac (Postscript): www.hp.com/support

● HP UPD PCL 6, PCL 5, PS: www.hp.com/go/upd

● Linux print drivers: www.hplip.net

● Unix drivers/model scripts: www.hp.com/go/unix and www.hp.com/go/unixmodelscripts

Software administration tools

● HP Managed Print Administrator (MPA): www.hp.com/go/mpa

The MPA tool does not support setting print modes for these products. A white paper located at
www.hp.com/go/upd on the Documentation tab, titled “HP Universal Print Driver - Creating and
Deploying Managed Printer Lists for the Universal Print Driver with HP Web Jetadmin 8.0 for use
with the Active Directory Administrative Templates” provides a method for setting print modes.

● HP Driver Deployment Utility: www.hp.com/go/ddu

DDU is used to package and deploy drivers, including silent installations, in enterprise
environments.

● HP Driver Configuration Utility: www.hp.com/go/dcu

DCU is used to configure driver features, like two-sided printing, prior to deployment.

● Citrix and Windows Terminal Services: www.hp.com/go/upd

On this site, click the Documentation tab, and then open the HP Universal Print Driver – System
Administrator’s Guide

● SAP device types/configuration files: www.hp.com/go/sap/drivers and www.hp.com/
go/sap/print

On this site, click the Documentation tab, and then open the HP Universal Print Driver – System
Administrator’s Guide

● HP Web Jetadmin (WJA): www.hp.com/go/webjetadmin

WJA is used in Windows enterprise environments to manage printers, deploy drivers, update
firmware, etc.

● Novell iPrint: www.novell.com/iprint

iPrint makes all your printing resources instantly accessible with a web browser.
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Printing from mobile devices

● HP ePrint: www.hpconnected.com (Available on select models)

NOTE: HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled
printer anytime, from any location. It is as simple as sending an email to the email address
assigned to your printer when you enable Web Services on the printer. No special drivers or
software are needed. If you can send an email, you can print from anywhere, using HP ePrint.
Once you have signed up for an account on ePrintCenter (or HP Connected), you can sign in to
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer's HP ePrint email address to print, and get help for HP ePrint.

● HP ePrint Mobile Driver: www.hp.com/go/eprintmobiledriver (Available on select models)

● Airprint: www.hp.com/go/airprint (Available on select models)

HP Embedded Web Server (EWS)

This product is equipped with an embedded Web server (EWS), which provides access to information
about product and network activities. The advantage of an EWS is that it provides an interface to the
product that anyone with a network connected product and computer can use. There is no special
software to install or configure, but you must have a supported Web browser on the computer. To gain
access to the EWS, type the IP address for the product in the address line of the browser.

NOTE: For Apple operating systems, you can use the HP EWS over a USB connection after installing
the software included with the product.

For more information, see the electronic help documentation that came with your product.
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In-box CD and Full Software Solution or Driver with
Installer on the Web (PCL6)

Install 

Before installing the software, see Supported operating systems on page 3 and Minimum system
requirements on page 3 to confirm your computer meets installation requirements.

You can install the printer over:

● 10/100 Ethernet LAN

● 802.11 B/G/N Single Band wireless on select models

● Hi-Speed USB 2.0 or higher

Installation steps

1. Insert the CD into CD ROM drive of your computer or download the drivers from the web at:
www.hp.com/support.

If connecting the printer using a USB cable, do not connect the cable until prompted.

NOTE: You can download the Full Software Solution or just the Driver with Installer
from the web.

● If the CD does not automatically start, browse to the CD drive of the computer, and double-
click Setup.exe.

● If you want a driver that supports select Windows Server Editions, download the driver from
the web and then use the command line method to install. You can select only the modules
that you want to install. The command line install is a silent install, so you will not see any
user interface screens. To learn more see the IT Administrator’s Install Guide.

● If you do not need a driver that supports select Windows Server Editions, you can download
the Full Software Solution or the Driver with Installer from the web, and then double-
click on the executable file (.exe) to start the installation. The Full Software Solution is the
same solution as the CD, and you will be able to select the recommended software you
would like to install. The Driver with Installer does not support the installation of any
additional software. When you install with the executable method, you will see user interface
screens to guide you through the install.

2. Follow the on-screen instructions.
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3. On select models, you might see the ePrintCenter screen if your printer is on a network and has
web access when you install. Select Go Online to install software drivers from the web. On
select models, you will be able to set up HP Web Services such as HP ePrint while you are online.

NOTE: HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled
printer anytime, from any location. It is as simple as sending an email to the email address
assigned to your printer when you enable Web Services on the printer. No special drivers or
software are needed. If you can send an email, you can print from anywhere, using HP ePrint.
Once you have signed up for an account on ePrintCenter (or HP Connected), you can sign in to
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer's HP ePrint email address to print, and get help for HP ePrint.
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4. If you are installing from the software CD or installing the Full Software Solution from the
web, you will see the Software Selections screen. Select Next to install all of the
recommended software or select Customize Software Selections, and then clear the box by
the software that you do not want to install.

NOTE: Recommended Software options might vary depending on the printer model.
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5. When you see the Connection Options screen, select how you want to install the printer
software.

NOTE: If your printer and network both support an Ethernet and a wireless connection, consider
using an Ethernet connection to ensure a more reliable connection to your network. If you use a
wireless connection you will need to make sure that the wireless signal is turned on and your
computer is within signal range of your printer.

Refer to the following table to determine the appropriate connection option for your printer. Some
of the connection options might not be available for your specific printer.

Selection option Requirements What you want to do

Wireless ● Your printer has a wireless network
(802.11) connection capability.

● Your computer is connected to a
Wireless 802.11 Local Area
Network (LAN) through a wireless
router/access point.

● Your printer’s wireless signal is
within range of your computer.

● You want to wirelessly connect
your printer to your network.

● You want other computers on your
network to have access to your
printer.

● You want to use features such as
HP ePrint and HP wireless direct.
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Selection option Requirements What you want to do

Wired Network ● Your printer has an Ethernet (wired
— 802.3) network connection
capability.

● You have a Local Area Network
(LAN) with an Ethernet (wired —
802.3) connection.

● You have an Ethernet cable
(Category 5 for example) for
connecting your printer to your
network.

● You want to use an Ethernet cable
to connect your printer to your
network.

● You want other computers on your
network to have access to your
printer.

● You want to use HP ePrint.

USB ● Your printer has a USB port.

● Your computer has a USB port.

● You have a USB cable.

● You want to use a USB cable to
connect your printer to your
computer.

● Your printer can only be used by
the computer that is directly
connected to your printer.

Connect later You complete installation of the printer
software on your computer, but you do
not connect your printer to your
computer.

You want to install the software on your
computer, but you want to connect your
printer to your computer later.

NOTE: If you want to connect later after you have installed the full software solution, go to the
computer’s start menu and then select All Programs > HP > HP Officejet Pro XXXX > Printer
Setup & Software > Connect a new printer.

Printer driver functions

Printing shortcuts tab

Use the Printing Shortcuts tab to select predefined settings for printing your document. When you select
an option from the Printing shortcuts menu, that option is reflected in the menu options on the right
side of the screen. You can also create your own printing shortcuts. Select Factory Defaults when
you want to reset the selections.

You can use a printing shortcut as it has been defined, you can modify a shortcut for the current print
job, or you can create and save a new shortcut for later use.
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Create and use printing shortcuts

1. Select a shortcut from the menu.

You will see the preselected settings on the right.

2. Click OK to use the settings that are displayed to the right, or use the drop-down menus to change
the predefined settings.

NOTE: You can change the default predefined settings for every option except Factory
Defaults.

3. If you changed the preselected settings, Save As and Reset are available.

Use Save As to create and name a new shortcut. If you want to use these settings just for the
current print job, click OK and then print your document.

Use Reset to change your selections back to default before you save the settings.

4. Click OK, and then print your document.

NOTE: Print Quality is not set from Printing Shortcuts. To clear print quality conflicts, use
the Paper/Quality tab.
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Paper/Quality tab

Use the Paper/Quality tab to specify paper size, type, and source. You can also specify different
paper selections for the front cover, first page, other pages, last page, and back cover of the
document.

Paper sizes Select a paper size from this drop-down menu. Use Custom to define a paper size not in the
menu.

Paper source Select the tray you want to use from this drop-down menu. Automatically Select uses the
source tray that supports the paper size you selected.

Paper type Select a paper type from this drop-down menu.

Special pages Select Settings to define different paper trays and paper types for the pages of your document.

Print Quality Select a print quality from this drop-down menu, and then select Resolution to view the print
resolution of the option that you have selected.

NOTE: The Resolution feature is only available in the PCL6 full-feature driver.

NOTE: If a paper type has only one supported print quality setting, the drop-down menu might
not appear.

Paper sizes

Paper-size settings in most software programs override driver settings, so it is generally best to use the
driver to set paper size only when you are printing from software programs that do not include a
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paper-size setting, such as Notepad, or when you are producing a book or a booklet that does not
require different paper sizes.

NOTE: Click on the paper dimensions above the drop-down menu box to switch between English and
metric dimensions of the selected paper size.

Custom Paper Size

To create a custom paper size:

1. Click Custom on the Paper/Quality tab to display the Custom Paper Size dialog box.

2. In the dialog box:

● Enter a name for the custom size that you want to create.

● Select Inches or Millimeters.

● Enter the dimensions that you want.

3. Select Save, and then OK to close the dialog box.

4. Close the printer properties, and then open printer properties again.

NOTE: The printer properties must be closed and reopened to access your new custom paper
size.

5. From the Paper size drop-down menu select the paper size that you created.

NOTE: If you want to view the dimensions of a custom paper size that you created, select the
name of the paper size from Paper size drop-down menu, and the select Custom.
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Paper source

Specify the source tray for printing a document with the Paper source drop-down menu. Available
trays vary by printer.

Automatically select is the default setting. When this setting is selected, the printer uses the source
tray that supports the paper size that you have selected. If you select a source tray other than
Automatically select, make sure that the correct paper size is loaded in the source tray.

Paper type

The default setting is Unspecified. If you select a paper type other than Unspecified, make sure that
the correct paper type is loaded in the selected Paper source tray.

You can choose specific paper types by selecting More, and then selecting a specific paper type in
one of the categories under Type Is.

Special pages

Open the Special Pages dialog box by selecting Settings from the Paper/Quality tab.

● If you want to add a blank cover or a preprinted cover to a document, use the Covers setting.
Use this setting for covers that are not pages within your document.

● If you want to use a different paper type for the first and/or last page of your document use the
Print pages on different paper setting.
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Create a Covers setting:

1. Select Covers from the Special Pages group box, and then select Settings.

2. Select an option for each of the following:

● Add a blank or preprinted cover – make sure cover paper is loaded in the tray that
you specify for Front, Back or Both

● Paper source – select the tray that has the cover paper

● Paper type – select the paper type for the cover

3. Select Add. You will see your cover settings appear in the list of Special pages defined for
the print job.

4. Select OK .
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Create a Print pages on different paper setting:

1. Select Print pages on different paper from the Special Pages group box, and select
Settings.

2. Select an option for each of the following:

● Pages in document – make sure appropriate paper is loaded in the tray that you specify
for the First or Last page.

● Paper source – select the tray that has the appropriate paper for the first or last page.

● Paper type – select the paper type for the first or last page.

3. Select Add. You will see the first or last page settings appear in the list of Special pages
defined for the print job.

4. Select OK .

Print quality

Select the print quality that you want from the Print Quality drop-down menu.

● Draft: This setting lets you print faster and use less ink. The print color will be lighter, but this
mode is perfect for drafts and everyday printing.

● Normal: Use this setting for quality documents.

● Best: Use this setting to produce the highest-quality photos.
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NOTE: Select Resolution to view the print resolution of the Print Quality mode that you have
selected. When only one print quality is supported for a paper type, the print quality drop-down menu
might not appear.

Effects tab

Use the Effects tab to resize your document to fit on a different size paper than the original document
or to add a watermark.
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Resizing options

Actual Size prints the document size set in the printer driver, and is the default setting. If you want the
printer driver to automatically reformat your document to a different target paper size, use Print
Document On. If you want to manually reduce or enlarge your document on your paper use % of
actual size.

Print Document On

1. Select Print Document On.

Scale to Fit is automatically selected, so your document will fit within the margins of the target
paper size. If you clear this box, your document might not fit on the target paper size.

2. Select the target paper size from the Print document on drop-down menu.

NOTE: Pages per sheet will be set to 1.

3. Select OK, and then print your document.

22 Chapter 2   Windows software ENWW



% of actual size

1. Select % of actual size.

2. Type a number from 25 to 400 to reduce the image by 25% or increase the size of the image by
as much as 400%. You can also use the slider bar and arrows to adjust the image. Refer to the
print preview image in the upper right corner of the printer driver to view the changes that you
have made.

NOTE: Pages per sheet will be set to 1.

3. Select OK, and then print your document.

NOTE: When larger paper sizes are selected on the Paper/Quality tab, the job will
automatically be scaled.

Watermarks

Open the Watermark details dialog box by selecting Watermarks from the Effects tab. Select
and edit an existing watermark, create a new watermark, or delete a watermark.
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Edit or create a watermark

1. From the Current Watermarks menu select New, if you want to create a new watermark, or
select an existing watermark.

● If you select New, Untitled will appear in the menu, and in the Watermark Message
text box below. Type your watermark text in the message box to add it to the menu.

● If you select [Username], the watermark will be the username that you use to log into the
network.

NOTE: You can save up to 30 watermarks. If you want to delete a watermark, highlight the
watermark, and then select Delete.

2. Edit the appearance of your watermark.

Use Message Angle and Font Attributes to edit the appearance of your watermark. You can
change the angle of the text and modify the type, color, shading, size, and style of the font. Refer
to the print preview image in the upper right corner of the printer driver to view the changes that
you have made.

3. Select OK to save your settings. If you make changes to multiple watermarks before selecting OK,
these changes will also be saved.

4. Define the pages that the watermark should be printed on.

● If you only want the watermark on the first page of the document, check First page only,
on the Watermark dialog box of the Effects tab.

● If you want the watermark on every page of the document, clear First page only, on the
Watermark dialog box of the Effects tab.

NOTE: If your document has watermarks on every page, and you print multiple pages of a
document on a sheet of paper, the watermark will appear on every page of the document within
the physical sheet. So if you print two pages per physical sheet, a watermark will be printed twice
on the physical sheet.

Finishing tab

Use the Finishing tab to print on both sides of the paper, print booklets, print multiple pages of a
document on one sheet of paper, and change the orientation of the document.
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Print on both sides

1. Select Print on both sides if you want to print on both sides of the paper.

2. Make additional modifications to the format of the document if you want.

● Select Flip pages up to orient the document as if bound on the top side. You cannot use
this setting with Booklet layout.

● Select Booklet layout to print pages in a booklet format, then select Left binding or Right
binding.

NOTE: Booklet layout will set 2 document pages per sheet of paper.

3. Select OK, and then print your document.
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Pages per sheet

1. Select Pages per sheet if you want to print multiple pages of your document on a sheet of
paper.

You will see the document changes reflected by the print preview image on the upper right corner
of the printer driver.

2. Select one of the Pages per sheet options from the drop-down menu.

NOTE: You can print a maximum of 16 document pages on a sheet of paper. You can only
select Booklet layout if you select 2 pages per sheet.

3. Make additional modifications to the format of the document if you want.

Select Print page borders if you want a line printed around the edge of each document page
on a sheet of paper.

Select a Page order from the drop-down menu to define where each document page will
appear on a sheet of paper.

Orientation

Most software applications will automatically set the page orientation of a document. If your
application does not set the orientation, or you want to change the orientation, use this setting.

1. Select Portrait or Landscape.

Portrait orients the document vertically on the page; Landscape orients the document
horizontally on the page. Changing orientation in the driver does not affect how the paper feeds
into the printer. You will see the document changes reflected by the print preview image in the
upper right corner of the printer driver.

2. If you want to rotate the page orientation of a document by 180 degrees, check Rotate by 180
degrees.

You might want to rotate an image if you are printing on pre-punched paper. You will not see
changes to this setting reflected by the print preview image in the upper right corner of the printer
driver.

Color tab

Use the Color tab if you want to print in grayscale, or adjust color and grayscale settings, or adjust ink
drying time, saturation, and spread.
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Automatic color and grayscale settings

HP EasyColor automatically improves mixed text with graphics documents and photo images that are
printed from common software applications. It is the default setting.

● Select HP EasyColor to optimize color print quality.

● Select both Print in Grayscale and HP EasyColor to optimize grayscale print quality. When
both settings are checked the printer will use black and color cartridges to print in grayscale.

Adjust color, grayscale, and ink settings

Disable HP EasyColor to manually adjust color and grayscale settings.

NOTE: See Printer features on page 31 for more information.

1. Clear HP EasyColor to disable automatic settings.

2. If you want to print in grayscale, select Print in Grayscale.

● Select Black Ink Only if you want to print using a black cartridge only.

● Select High Quality for superior grayscale quality, using both black and color cartridges.
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3. If you want to change how the printer renders colors from the computer screen, select a setting
from the RGB color drop-down menu. These settings can be adjusted for color and grayscale
printing.

Default (sRGB) Use this setting for most of your printed documents to get vivid images and graphics. Colors
are optimized to match the RGB settings on the computer screen.

Photo (sRGB) Use this setting for an alternative rendering of raster images. Only raster data is affected by
this setting.

Photo (Adobe RGB
1998)

Use this setting for images created with a digital camera or color documents that were
originally created with Adobe RGB (1998). If you are printing from a professional software
program with Adobe RGB (1998), you should turn off the color management in the software
program and allow the printer software to manage the color space.

Vivid (sRGB) Use this setting for graphics with saturated areas of color such as pie charts and bar graphs.
Business documents with graphs and charts, but not photo images, can be printed with this
setting.

Services tab

Use the Services tab to link to online tools, support, and product information.
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● Select Select a destination to access diagnostic tools, support and troubleshooting, printer
manuals, and driver updates.

● Select Device Services to open the printer’s Embedded Web Server (EWS). The EWS provides
information about ink levels, printer usage, features available, Web Services such as ePrint,
network status, and Energy Save Settings.

Advanced tab

If the software application supports changing settings such as number of copies and collation, change
the settings in the software application. If the software application does not support these settings, use
the Advanced tab. Change other settings such as Color and Layout on the Color tab and
Finishing tab, respectively. Other settings on this tab are for advanced use.
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Copy Count

If a software program does not have a copy count setting, you can set copy count here. Type or use the
arrows to set the number of copies from 1 to 9999. If a software program has copy count, set the copy
count in the software to avoid conflicts between the program settings and the printer driver settings. If
you select more than one copy, you will also be able to select Collated, to collate. Set collation in the
software program, instead of the printer driver, if it is available.

Image Color Management

Image Color Management (ICM) defines the range of colors that can be printed. The printer software
translates the colors of an image from the current color settings to the color management option that is
selected.

Select an ICM Method from the following:

● ICM Disabled – use the software program to manage the color of the document.

● ICM Handled by Host System – use the operating system to manage the color of the
document.

● ICM Handled by Printer – use the printer driver to manage the color of the document.
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Select an ICM Intent from the following:

● Pictures – use for photographs and pictures with blended colors and color gradations.

● Graphics – use for charts and graphs that have bright saturated colors.

● Match – use to preview the color settings from another printer.

● Proof – use for matching a color exactly when you are sending a document to a printer that has
a specific color of ink.

True Type Font

The printer can use True Type fonts or it can substitute fonts for True Type.

● Substitute with Device Font – The printer will use equivalent fonts to print documents with
TrueType fonts. This permits faster printing; however, you might lose special characters that the
printer font does not support. This is the default setting.

● Download as Softfont – This setting causes TrueType fonts to be downloaded and used for
printing, instead of using printer fonts.

Advanced Printing Features

When the Advanced Printing Features setting is Enabled, metafile spooling is turned on.
Metafile spooling reduces the time between a request to print (initiated by an application) and the
return of control to the application by the operating system. For normal printing, leave the Advanced
Printing Features setting at Enabled.

Print Optimization

The default setting for Print Optimizations is Enabled. When this feature is enabled and your
document contains overlapping text and graphics, the text that is placed on top of a graphic might not
print correctly. If the printed output is not correct, you can disable this feature. When this feature is
disabled, print optimization-features, such as substituting device fonts for TrueType fonts and scanning
for horizontal and vertical rules, are turned off.

Printer features

Print All Text as Black The feature is Disabled by default. When Enabled is selected, the driver prints all text as black
regardless of the original document text color. This setting does not affect graphic images on the
page, nor does it affect any text that is part of a graphic.

When General Office or Professional Quality print mode is selected, black text will be
printed using black ink only. When other print quality modes are selected, black text will be
printed using both black and color ink.
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Send True Type as Bitmap Send True Type as Bitmap provides an alternative for software programs that have trouble
using TrueType fonts for special graphic aspects such as shading, rotation, or slanting. The setting
is Disabled (off) by default. The TrueType fonts are converted to bitmap soft fonts before
downloading. The Enabled setting causes the driver to send TrueType fonts to the product as
outlines, which retains the standard format (outline) of the fonts.

Raster Compression Select the graphics-compression method:

Automatic - The software determines the best compression method to use.

Best Quality - The software does not lose any data during the compression.

Maximum Compression - The software loses data during the compression.

Choosing this option increases the print speed performance, but does decrease print image
quality.

Page Order

Use this option to specify the order in which pages of your document are printed. Front to Back starts
printing from page one. Back to Front starts printing from the last page.

HP Scan

HP scanning software may be included as part of the installation on select models. Use the HP Scan
application to scan a document from your computer. For more information, see the electronic help
documentation that came with your product.

Uninstall

Use the Windows operating system Control Panel to uninstall the printer driver and any recommended
software that you installed with the printer driver. If you uninstall the HP software using the HP printer
program group, not everything will be uninstalled.

NOTE: To remove the software, you must log on with Administrator privileges.

1. Navigate to the Windows Control Panel.

2. Follow the steps for the operating system:

● Windows 8, Windows 7, and Windows Vista: From the Control Panel select
Programs, and then select Uninstall a program.

● Windows XP: From the Control Panel double-click Uninstall a program item.

3. Highlight the name of the HP printer software that you want to uninstall, and then select Uninstall
follow the on-screen instructions.
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HP Universal Print Drivers on the Web (HP UPD PCL
5, PCL 6, and PS drivers)

Use the HP UPD driver if you are an IT/System Administrator and you want to manage the software
over a network.

● The HP UPD driver only supports printing. Scan and fax are not supported by the HP UPD even if
your printer supports these functions.

● Before installing the software, see Supported client operating systems on page 4 and Supported
server operating systems on page 5 to confirm installation requirements.

● Download the HP UPD software and documentation at: www.hp.com/go/upd.
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3 Mac software
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Mac software and utilities

Install

Install the software on any computer that has save rights to the product. Users must have Administrator
rights to install the software.

NOTE: If the computer is connected to the product by a LocalTalk (printer port) connection, you must
configure the AppleTalk (or network) control panel for the correct connection to communicate with the
product. Mac operating systems do not support parallel connections.

Installation steps

You must set up the product, connect it to the computer or network, and turn it on before the software is
installed. Refer to the printed installation guide that came with your printer.

1. Insert the CD into CD ROM drive of your computer or download the drivers from the web at:
www.hp.com/support.

2. Double-click the HP Installer icon.

3. Follow the on-screen instructions.
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4. On select models, you might see the ePrintCenter screen if your printer is on a network and has
web access when you install. Select Go Online to install software drivers from the Web (you
might be redirected to HP Connected). On select models, you will be able to set up HP Web
Services such as HP ePrint while you are online.

NOTE: HP ePrint is a free service from HP that allows you to print to your HP ePrint-enabled
printer anytime, from any location. It is as simple as sending an email to the email address
assigned to your printer when you enable Web Services on the printer. No special drivers or
software are needed. If you can send an email, you can print from anywhere, using HP ePrint.
Once you have signed up for an account on ePrintCenter (or HP Connected), you can sign in to
view your HP ePrint job status, manage your HP ePrint printer queue, control who can use your
printer's HP ePrint email address to print, and get help for HP ePrint.
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5. If you are installing from the software CD or from the web, you will see the Installation
Options screen. Select HP Recommended Software or use the check boxes to customize
your software selections.

NOTE: Recommended Software options might vary depending on the printer model.
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6. For network connections only: In the Select Printer screen, click the Add Printer button
and follow the on-screen instructions.

NOTE: For USB connections, the installer program automatically sets up the product in the
Printers list.

In the Add Printer list that appears, click the product to be installed, and then click the Add
button.

7. When the software installation is complete, click the Close button.

Add printer

If you did not click the Add Printer button during the initial installation process, do the following:

1. Make sure printer is on.

2. If you are installing the product using a USB connection, connect the USB cable between the
printer and the computer. If you are installing using a network connection, verify that the network
cable is connected to the printer.

3. From the Apple menu, click the System Preferences menu, and then click the Print & Scan
icon.

4. Click the plus sign (+) and follow the on-screen instructions to complete the software installation.

NOTE: The HP driver may not be the default driver. If you would like to use the HP driver, you
may need to manually select the HP driver from the pop-up menu.

Printer driver functions

HP extends driver functions with plug-ins that provide access to product features, such as number of
copies, duplexing, and print quality settings. These plug-ins are HP additions to Apple's printer driver.
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Cover page

Select Before document or After document to enable cover page printing options.

The cover page will include details of the print job, such as:

● Job ID

● Title

● Printed for

● Printed from

● Billing information (optional)

Paper/Quality

Media type

● The default setting is Unspecified. If you select a paper type other than Unspecified, make sure
that the correct paper type is loaded in the selected Paper source tray.

Print quality

● General office: Used for general printing.

● Professional: Used when a higher quality print is desired.

● Presentation: Used when the highest quality print is desired.

● Maximum DPI: Use maximum dots per inch (dpi) mode to print high-quality, sharp images on
photo paper.
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NOTE: Maximum DPI is only available when HP Advanced Photo Papers is the selected
Media Type.

Color options

HP EasyColor automatically improves mixed text with graphics documents and photo images that are
printed from common software applications. It is the default setting.

● Select HP EasyColor to optimize color print quality.

● Select both Print Color as Gray and HP EasyColor to optimize grayscale print quality. When
both settings are checked the printer will use black and color cartridges to print in grayscale.
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Adjust color, grayscale, and ink settings

Disable HP EasyColor to manually adjust color and grayscale settings. When HP EasyColor is
disabled you will also be able to change Dry Time, Saturation, and Black Ink Spread from the
Ink Settings menu.

1. Deselect HP EasyColor to disable automatic settings.

2. If you want to print in grayscale, select Print Color as Gray.

● Select Black Ink Only if you want to print using a black cartridge only.

● Select High Quality for superior grayscale quality, using both black and color cartridges.

3. If want to change ink drying time, saturation, or spread, click the Advanced disclosure triangle
and then adjust settings using the sliders for each option.

NOTE: Changing Ink Settings manually might impact printed output. HP recommends that
only color graphics experts change these settings.

4. If you want to change how the printer renders colors from the computer screen, choose a setting
from the RGB color pop-up menu. These settings can be adjusted for color and grayscale printing.

Default (sRGB) Use this setting for most of your printed documents to get vivid images and graphics. Colors
are optimized to match the RGB settings on the computer screen.

Photo (sRGB) Use this setting for an alternative rendering of raster images. Only raster data is affected by
this setting.

Photo (Adobe RGB
1998)

Use this setting for images created with a digital camera or color documents that were
originally created with Adobe RGB (1998). If you are printing from a professional software
program with Adobe RGB (1998), you should turn off the color management in the software
program and allow the printer software to manage the color space.

None Use this setting to accept RGB data directly from the software application.

Vivid (sRGB) Use this setting for graphics with saturated areas of color such as pie charts and bar graphs.
Business documents with graphs and charts, but not photo images, can be printed with this
setting.

Booklet printing

Select Format Output as Booklet to enable booklet printing options.

NOTE: To print a booklet, two-sided printing must be turned on. To enable two-sided printing, choose
Layout from the pop-up menu, and then choose either Long-edge Binding or Short-edge
binding from the Two-Sided pop-up menu.
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Watermarks

Select Watermark to enable watermark options. Use the pop-up menus to edit the appearance of
your watermark. You can change the angle of the text and modify the type, color, shading, size, and
style of the font.

NOTE: Select Custom from the Text pop-up menu to enter your own watermark text.
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HP Utility

HP Utility gives you access to many product settings in OS X. HP Utility does not work when it is
installed by using the AppleTalk protocol. Use IP, Bonjour, or Rendezvous to enable HP Utility.
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HP Utility is located in the Hewlett-Packard folder in the Applications folder at the top level of the hard
disk.

Sections Content

Information and Print
Quality

Use the HP utility to check on supply and device information, maintenance tools, and more.

● Supplies Status on page 46

● Supply Info

● Device Information

● Clean Back of Page Smear

● Clean Printheads

● HP ePrintCenter

● Print Quality Diagnostics

Printer Settings ● Device Administration

● Network Settings

● Paper Handling

● Trays Configuration

● Supplies Management on page 46

● Additional settings on page 47
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Sections Content

Fax Settings (available on
select models)

● Basic Fax Settings

● Junk Fax Blocking

● Fax Forwarding

● Fax Logs

● Fax Speed Dials

Scan Settings (available
on select models)

● Scan to Computer

● Scan to E-mail

● Scan to Network Folder

Information and print quality

Supplies Status

In the Information and Print Quality section, click the Supplies Status icon to open the
Supplies Status screen.

Click the Detailed Supplies Information button to get information about ink cartridges, part
numbers, cartridge expiration dates, and links to order ink supplies online.

Printer settings

Supplies Management

Click the Supplies Management icon to set the user defined low threshold value. When the ink
supply reaches the low threshold you have defined, you will get an alert.
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Additional settings

In the Printer Settings section, click the Additional Settings icon to open the HP Embedded Web
Server (EWS). For information about HP EWS settings, see the electronic help documentation that came
with your product.

HP Scan

HP scanning software may be included as part of the installation on select models. Use the HP Scan
application to scan a document from your computer. For more information, see the electronic help that
came with your product.

Uninstall

You must have administrator rights to uninstall the software.

1. From the Apple menu, click the System Preferences menu, and then click the Print & Scan
icon.

2. Highlight the product.

3. Click the minus (-) symbol.

4. Delete the print queue, if necessary.
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4 HP Digital Solutions
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Requirements

Digital Solution Requirements

For all HP Digital
Solutions

● A network connection

Connnect your printer through a wireless router or an Ethernet cable to your network.

● The HP software

HP recommends that you set up HP Digital Solutions using the HP software provided with the
printer.

TIP: If you would like to set up HP Digital Solutions without installing the HP software, you
can use the HP Embedded Web Server.

For Scan to Network
Folder, Fax to Network
Folder

● Active network connection

● Existing shared folder on the network

◦ Network address for the folder

◦ Name of the computer where the folder is located

◦ Write access to the shared folder

◦ Username and password for the shared folder (if necessary)

NOTE: HP Direct Digital Filing does not support Active Directory.

For Scan to Email, Fax to
Email

● A valid email address

● Outgoing SMTP server information

● An active Internet connection

If you are setting up Scan to Email or Fax to Email on a computer running Windows, the setup
wizard can automatically detect the email settings for the following email applications.

● Microsoft Outlook 2003–2007 (Windows XP, Windows Vista, and Windows 7)

● Outlook Express (Windows XP)

● Windows Mail (Windows Vista)

● Mozilla Thunderbird (Windows XP, Windows Vista, and Windows 7)

● Qualcomm Eudora (version 7.0 and above) (Windows XP and Windows Vista)

● Netscape (version 7.0) (Windows XP)
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Scan to Network Folder
Scan documents directly to computer folders on your network. These scanned documents can be sent to
a shared network folder for personal or group access. In addition, you can configure specific scan
settings for each scan destination, so the best settings are being used for each specific task.

Set up Scan to Network Folder

You can configure up to 10 destination folders for each printer.

NOTE: To use Scan to Network Folder, you must have created and configured the folder you are
using on a computer connected to the network. You cannot create a folder from the printer's control
panel. Also, make sure the folder preferences are set to provide read and write access.

Windows

1. Open the HP Printer Software.

2. Go to the Scan section under the Print, Scan and Fax, and then double-click Scan to
Network.

3. Follow the on-screen instructions.

NOTE: After you create destination folders, you can use the HP Embedded Web Server (EWS)
to customize the scan settings for these folders. On the last screen of the Scan to Network Folder
Wizard, make sure the Launch embedded web server when finished check box is
selected. When you click Finish, the EWS is displayed in your computer’s default web browser.
For more information about the embedded web server, see HP Embedded Web Server (EWS)
on page 7.

OS X

1. Open HP Utility. For more information, see HP Utility on page 44.

2. Click Scan to Network Folder under the Scan Settings section, and then follow the on-
screen instructions.

NOTE: You can customize the scan settings for each destination folder.

HP Embedded Web Server (EWS)

1. Open the HP Embedded Web Server (EWS).

2. On the Home tab, click Network Folder Setup in the Setup box.

3. Click New, and then follow the on-screen instructions.

NOTE: You can customize the scan settings for each destination folder.

4. After you have entered the required information about the network folder, click Save and Test to
make sure the link to the network folder is working correctly. The entry is added to the Network
Folder list.
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Use Scan to Network Folder

1. Load your original print-side down on the right-front corner of the scanner glass or print-side up in
the ADF.

2. Touch Scan, and then touch Network Folder.

3. On the control panel display, select the name that corresponds to the folder you want to use.

4. If prompted, enter the PIN.

5. Change any scan settings, and then touch Start Scan.

NOTE: The connection might take some time, depending on network traffic and connection speed.
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Scan to Email
Scan documents and quickly share them as email attachments. These scanned documents can be sent
to one or more email addresses for quick sharing. In addition, you can configure specific scan settings
for each scan destination, allowing you to make sure that the best settings are being used for each
specific task.

Set up Scan to Email

You can use the printer to scan documents and send them to one or more email addresses as
attachments.

1. Set up the outgoing email profiles.

Configure the email address which will appear in the FROM portion of the email message sent by
the printer. You can add up to 10 Outgoing Email Profiles. You can use the HP software
installed on your computer to create these profiles.

Windows

a. Open the HP printer software.

b. Go to the Scan section under the Print, Scan and Fax, and then double-click Scan to E-
mail Wizard.

c. Click New, and then follow the on-screen instructions.

NOTE: After you set the Outgoing Email Profile, you can use the HP Embedded Web
Server (EWS) to add more Outgoing Email Profiles, add email addresses to the Email
Address Book, and configure other email options. To open the EWS automatically, make sure
the Launch embedded web server when finished check box is selected on the last
screen of the Scan to Email Wizard. When you click Finish, the EWS is displayed in your
computer’s default web browser.

OS X

a. Open HP Utility. For more information, see HP Utility on page 44.

b. Click Scan to Email under the Scan Settings section.

c. Follow the on-screen instructions.

d. After you have entered the required information about the network folder, click Save and
Test to make sure the email configuration is working correctly. The entry is added to the
Outgoing Email Profiles list.

HP Embedded Web Server (EWS)

a. Open the HP Embedded Web Server (EWS).

b. On the Home tab, click Outgoing Email Profiles in the Setup box.
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c. Click New, and then follow the on-screen instructions.

d. After you have entered the required information about the network folder, click Save and
Test to make sure the email configuration is working correctly. The entry is added to the
Outgoing Email Profile List.

2. Add email addresses to the Email Address Book.

Manage the list of people to whom you can send email messages from the printer. You can add
up to 15 email addresses with their corresponding contact names. You can also create email
groups. To add email addresses, you can use the HP Embedded Web Server (EWS) or the
printer’s control panel.

a. Open the HP Embedded Web Server (EWS).

b. On the Scan tab, click Email Address Book.

c. Click New to add a single email address or click Group to create an email distribution list.

NOTE: Before you can create an email distribution list, you must have already added at
least one email address to the Email Address Book.

d. Follow the on-screen instructions. The entry is added to the Email Address Book.

NOTE: Contact names appear on the printer’s control panel display and in your email
application.

3. Configure other email options.

To configure other email options (such as configuring default SUBJECT and body text that is
included in all email messages sent from the printer, as well as scan settings used when sending
email from the printer), complete the following steps:

a. Open the HP Embedded Web Server (EWS).

b. On the Scan tab, click Email Options.

c. Change any settings, and then click Apply.

Use Scan to Email

1. Load your original on the scanner glass or print-side up in the ADF (available on select models).

2. Touch Scan, and then touch Email.

3. On the control panel display, select the name that corresponds to the Outgoing Email Profile you
want to use.

4. If prompted, enter the PIN.

5. Select the TO email address (the email recipient) or enter an email address.

6. Enter or change the SUBJECT for the email message.

7. Change any scan settings, and then touch Start Scan.
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NOTE: The connection might take some time, depending on network traffic and connection speed.
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HP Digital Fax

Set up HP Digital Fax

With HP Digital Fax (available on select models), the printer automatically receives faxes and saves
them directly to a network folder (Fax to Network Folder) or forwards them as email attachments (Fax to
Email).

NOTE: You can configure HP Digital Fax to use either Fax to Network Folder or to use Fax to Email.
You cannot use both at the same time.

Received faxes are saved as TIFF (Tagged Image File Format) or PDF files.

NOTE: HP Digital Fax is available for receiving black-and-white faxes only. Color faxes are printed
instead of being saved.

Windows

1. Open the HP printer software.

2. Go to the Fax section under the Print, Scan and Fax, and then double-click Digital Fax
Setup.

3. Follow the on-screen instructions.

NOTE: After you set up HP Digital Fax, you can use the HP Embedded Web Server (EWS) to
edit HP Digital Fax settings. To open the EWS automatically, make sure the Launch embedded
web server when finished check box is selected on the last screen of the Digital Fax Setup
Wizard. When you click Finish, the EWS is displayed in your computer’s default web browser.

OS X

1. Open HP Utility. For more information, see HP Utility on page 44.

2. Click Digital Fax Archive.

3. Follow the on-screen instructions.

4. After you have entered the required information, click Save and Test to make sure the link to the
network folder is working correctly.

Use HP Digital Fax

After you set up HP Digital Fax, you can use the HP Embedded Web Server (EWS) to edit HP Digital
Fax settings. To open the EWS automatically, make sure the Launch embedded web server
when finished check box is selected on the last screen of the Digital Fax Setup Wizard. When you
click Finish, the EWS is displayed in your computer’s default web browser.
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NOTE: Any black-and-white faxes that you receive print, by default, and then are saved to the
designated destination—either the network folder or email address that you have specified.

● If you are using Fax to Network Folder, this process happens in the background. HP Digital Fax
does not notify you when faxes are saved to the network folder.

● If you are using Fax to Email and if your email application is set to notify you when new email
messages arrive in your inbox, you can see when new faxes arrive.
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